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ENTER RECORDS MANUALLY 

 
 
There are three ways to add references to your database: 

1) Manual entry of each item 
2) Import of electronic files 
3) Automatic download from Internet services 

 
Virtually, all bibliometric packages offer (1) and (2); some offer (3) as well.  We'll start with a 
manual entry in order to understand how a bibliographic database constructs records. 
 
Open a New Record 
• From the Reference Pulldown menu, select New or press the <Insert> key.  A black 

Reference Edit window appears.  All of your entry information can be placed in this single 
window—a big improvement over older versions of this and other packages. 

 
• All bibliometric packages automatically assign a unique Reference ID to each record in the 

database. 
 
• Notice that RM includes a Web/URL field—a feature becoming standard in bibliometric 

packages.  If you include a Web address, RM will automatically launch your Web browser, 
initiate your Internet connection, and bring up the URL. 

 
• Notice that RM version 9 includes a spell checker.  Think about whether you need such a 

feature when shopping for a package. 
 
• You can enlarge the edit box to full screen size or work on it in popup size, as you prefer. 
 
Choose a Reference Type       Journal 
• RM automatically defaults to the reference type last used, or to "generic," if being used for 

the first time.  Select the Journal reference type from the scroll menu, and then press 
<Enter>. 

 
• What's the difference between "Journal" and "Journal (Full)?"  The (Full) version adds extra 

fields used by librarians to identify journals.  We'll use the simpler plain "Journal" for our 
class. 

 
Enter the Article Title 
• Reference Manager does not change capitalization when producing bibliographies.  If you 

regularly publish in a particular journal, follow that journal's suggested format when entering 
titles. 
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• Do not use quotations or place a period at the end of a title. Reference Manager will supply 

any necessary punctuation for bibliographic output. 
 
• When finished, press <Tab> to move to the next field. 
 
• When a keyword you have used before is included in the title text, RM automatically adds it 

to the keywords field as soon as you proceed to the next field or save the reference. 
 

 
 
Enter Authors' Names 
• Enter names Last Name first, as in these examples.  Notice the use of spaces, commas and 

periods to distinguish elements of a name.  RM uses the punctuation as codes to reformat 
names as needed to match bibliographic styles, so it is important to pay attention to the 
format. 

 
Seagull,J.L. Seagull,Jonathan L. 
Seagull,Jonathan Seagull,Jonathan Livingston 
 ^ ^ 
 no space space 

 
• Type a semicolon ( ; ) or use the right arrow ( ) to enter additional authors.  Each record 

may contain up to 255 authors. 
 
Enter Publication Date 
• The Publication Date is usually a year.  Click the Calendar Icon to eliminate the day and 

month divisions and enter just the year. 
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Enter Notes 
• You are never required to enter anything in the Notes field.  If desired, however, it can 

contain Unique Identifiers, parenthetical comments, or evaluations. 
 
• Press <Tab> to move to the next field. 
 
• As with titles, when a keyword you have used before is found in the Notes text, RM will 

automatically add it to the keywords fields as soon as you proceed to the next field or save 
the reference. 

 
Enter Keywords 
• Keywords are the key to an effective filing system. Keywords identify topics, uses of 

material, individuals associated with materials, and more.  Grant numbers and project titles 
also make effective keywords.  Most importantly, be consistent!  RM makes it easy by 
providing a dictionary list of keywords whenever you add records. 

 
• Type a semicolon ( ; ) or use the right arrow (  ) to enter additional keywords.  When 

finished, press <Tab> to move to the next field.  Notice that RM alphabetizes your keywords 
when you move on to the next field. 

 
• Each reference may contain up to 255 keywords.  You are free to use abbreviations or capital 

letters as you please.  Alphabetical order doesn't matter. 
 
• When you add new keywords to your database, RM automatically searches the title and notes 

fields of all records for the new keyword and adds it to the keyword field of the records 
found. 

 
Select Reprint Status      Not In File 
• Reprint status is just a selection box, not an entry to type.  This feature allows you to keep 

track of whether you actually have a copy on file, or have ordered it.  It is a very useful 
feature for research groups. 

 
Enter Journal Name 
• Enter the full journal name or the standard abbreviation of the journal.  This should be the 

standard abbreviation that you want to use in your bibliographies.  For example, the Journal 
of Clinical Investigation becomes J.Clin.Invest. and Kidney International becomes Kidney 
Int.   

 
• Reference Manager can identify both the full journal name and its abbreviation using the 

Term Manager and Synonyms feature.  It will then select the appropriate form for a 
bibliography based on the output format you select. 

 
• When finished, press <Tab> to move to the next field. 
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Enter Volume/Issue/Start Page/End Page 
• Enter the appropriate numbers.  It's okay to leave some fields blank. 
 
Enter Abstract 
 
• Like the Notes field, the Abstract can hold any type of text or numerical comment.  When 

importing search results from an electronic database, abstracts automatically load into this 
field.  You may also enter an abstract manually. 

 
• You are never required to enter an abstract. 
 
Other Fields 
 
• Several additional fields are available to describe contact information for the author, or for 

you to customize. 
 
Save the Record 
 
• Check your work with the spell checker on the tool bar.  Then, from the File pulldown menu, 

select Save <Ctrl+S>, or Save and New <F9> if you want to enter another reference.  You 
can also save references by clicking the floppy disk icon on the toolbar. 

 
• If RM suspects a duplicate reference, a message box will ask you if you want to review it. 
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ENTER RECORDS AUTOMATICALLY: 

Search & Download Directly from Web-Based Databases 
 
 
Some bibliometric programs can now use their own search interfaces to search databases on the 
Web, automatically downloading search results.  PubMed will be our class example.  Other 
vendors can be used, including ID-protected databases, as long as the provider is Z39.50 
compliant. 
 
Set Some Options First 
 
• From the Tools pull down menu, select Options. 
 
• Choose the Internet Search tab, and check the box to "automatically display the internet 

search result."  Set the number of documents to display at 5. 
 
Initiate a Search Session 
 
• On the References pulldown menu, choose Internet Search OR click the binoculars icon on 

the tool bar. 
 
• In the Retrieval box, check the box for Internet Search.  PubMed will appear in the box as the 

database to be searched. 
 
• Choose the field(s) and term(s) to be searched, and then click the big binocular icon in the 

tool bar to start the search.  Note the variety of fields offered in the search, including MESH 
terminology. Double click to select the MESH TERM field and enter LATEX ALLERGY as 
the parameter. 
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• RM will automatically perform the search, placing the first 5 resulting records in a separate 

database with its own tab, and giving it a search number, such as Search 1.  Note that if we 
hadn't checked the automatic retrieval and limited our set to 5 records, RM would have 
performed the search, reported the results, and asked permission to import them. 

 
• After you review and edit or approve the records you retrieved, you can move the results into 

any other open database. 
 
• Double click on any record to see it in an editing window.  Notice RM imported the MESH 

terms as keywords, put material that didn't fit a field into the Notes area, and included the 2-
letter field tags.  If an abstract was available, RM placed it in the abstract field. 

 
• You may now edit records as needed, mark and delete unwanted records, or mark the records 

you want to include in your permanent database. 
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Transfer Records to Your Class Database 
 
From the References pulldown menu, choose Copy Between Databases. 
 
Since RM allows you to work on several databases at the same time, you need to choose which 
of your open databases is the source and which is the destination.  You can move from one to all 
of the records.  In the dialogue box, select the All References in List option. 
 

 
 
Click the Copy button.  RM will ask for confirmation.  Answer Yes to All.   
 
RM notifies you that the ID numbers are duplicated, since you already have some records in your 
Class database. Answer Yes to All to proceed with the copying.  RM will assign new ID numbers 
to the records. 
 
If you are now done with the search set, you may delete it.  Use the File pulldown menu.  
Choose Delete Database and answer the programs' questions about which one to delete. 
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ENTER RECORDS AUTOMATICALLY: 
Import Existing Text Files 

 
 
The Import Text service allows RM to read the saved output of literature database programs, 
such as OVID™ and Silver Platter™, and automatically import records.  This is a two-step 
process, in which the formats need to be matched: 
 

Step 1 Download database information in a specific format, and name the file with a 
.doc or .txt extension.  (For example, mystuff.doc or mystuff.txt.) 

 
Step 2 Tell Reference Manager what format to use to read, and upload the results of the 

search. 
 
WARNING!!  Electronic databases do not consistently use a standardized format.  In general, a 
standardized format is used only for journal articles.  Therefore, RM may not properly read other 
reference types such as whole book or book chapter.  You may use Import Text File to import 
these item types into RM, but they may require further editing. 
 
Set the Conditions for Import 
• From the Tools pulldown menu, select Options <F11>. 
 
• Select the Import folder.  Import allows you to customize three aspects of a capture session: 

1) Whether to confirm each reference as it comes into the database 
2) What to do with records if you are doing multiple captures 
3) What to do with duplicate records 
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Import Folder 

 

 
 
• If you check the box, Confirm import of each reference, RM will pause on each item as it 

loads and ask you to confirm its inclusion into your database.  If you are importing more than 
10 items into your database, you probably do not want to select this option, as it will greatly 
increase the amount of time it takes for RM to complete the upload. 

 
• The Previous session options allow you to add the current uploaded items to a file from a 

previous capture session.  This is useful if you want to maintain a database of captured items 
entirely separate from your main database for independent manipulation. 

 
• The Duplicate references options direct RM to save suspected duplicate items into a unique 

database for later review, to save into your database without change, or to not import.  If you 
choose Put in duplicate database, RM lets you name a file to hold them; it offers a default of 
C:\Program Files\Reference Manager 9 Demo\ImprtDup. 

 
• Next, review the Reference Edit folder.  Don't make any changes now, but observe our 

choices to scan for keywords, highlight fields, and assign a Reference ID to the records you 
will be importing. 

 
• Finally, select the Duplicate Search folder.  The options listed here specify the fields RM 

uses to identify duplicate records. 
 
• Confirm that Title, primary; Authors, primary; Date, primary; and Periodical are selected.  

You may also add fields from the scroll menu in Fields to Compare. 
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The Import Process 
 
• From the References pull down menu, select Import Text File… 
 
• You will tell RM where to find the text file, how to read it, and where to put it.  Other 

instructions are all optional. 
 
• For Database, select the RM database into which the new records should be placed.  The 

scroll down list offers all currently open RM databases. 
 
• Use the […] browse button to look at all the Filter options.  The filter you select needs to 

match the citation format in which the records were saved.  Choose OVID ONLINE 
REPRINT FJ, to match the way your sample records were saved. 

 
• Note that you can edit filters and that new filters can be downloaded from most vendors' Web 

sites.  Most major bibliometric software vendors offer this service. 
 
• Tell RM where to find the items saved from your database search.  In the Text file window, 

select a:\mystuff.txt from the scroll down menu. 
 
• If you want to verify the contents of your text file before you import it, select the View Text 

File button.   
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• Finally, you may choose to upload all of the items in a file or specify a range of items, set 

some universal keywords to include with all the records, or assign a reprint status to all the 
records imported. 

 
• When your selections match the box below, click <Import> to begin. 
 

 
 
 
• Reference Manager shows the records in the Import Text file contents window as they load.  

When the upload is complete, a box announces the import was successfully completed.  Click 
OK. 

 
• Notice that while all of the articles have been added to the main database, RM allows you to 

look at just the records you imported in a special temporary work area, with its own tab 
labeled Imported.  That work area will disappear when you close this working session with 
your database. 

 
• Click the Class tab to return to your main database and verify for yourself that several new 

records were added. 
 
• The box updates itself to show the number of records retrieved for each parameter. 
 
• The Retrieved database will disappear when you close this session of Reference Manager.  

Any subsequent searches you do will replace the records in Retrieved with your new results.  
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CREATE A BIBLIOGRAPHY 
 
 
• Choose the Bibliography folder, and type a title for your document in the Bibliography Title 

window. 
 
• WARNING!!  Any additional information entered in the Bibliography folder, such as 

indentation or numbering of references, will override the Output Style.   
 
• In the Page folder, you may specify page margins and format page numbering, if that is 

important.  Otherwise, RM uses standard default settings. 
 
• Click <OK>.  A Save As folder automatically appears, asking you where to put the new file. 
 
• In the File name window, type a:\bib.doc.  (Remember to include a pathname, such as 

a:\filename.doc and to include the .doc or .txt extension so your word processor will 
recognize the document.) 

 
• In the Save as type box, select a word processor from the scroll menu.  Notice that you can 

also save your bibliography in hypertext markup language (HTML), for mounting on the 
World Wide Web. 

 
• Click on the <Save> button. 
 
Use a Word Processor to View the Finished Bibliography 
 
The bibliography now exists on your floppy diskette or hard drive, as specified.  Let's check its 
appearance: 
 
• Open your word processor and, from the File pull down menu, select Open. 
 
• In the File Name box, type the path and name of your file, a:\bib.doc. 
 
• Click <OK>. 
 
• The file is now available for any final editing or manipulation required.  It can be added to 

another document, if needed. 
 
• If you saved your file as Type HTML, you may view the file in any web browser. 
 
See Appendix I for examples of how the same two records appear in different output styles. 
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CITE WHILE YOU WRITE 

 
 
 
Not only does Reference Manager produce bibliographies upon demand, it can also integrate 
with your word processor to insert citations in your manuscript as you compose it, and to format 
your entire manuscript for submission to publishers. 
 
The following example document both instructs in the three ways to insert citations into 
manuscripts, and demonstrates the appearance of a completed document. 

 
Sample Document in American Psychological Association Style 

 
1. The sample database which comes with Reference Manager contains works by Au (Au, 

1992), Boyd (Boyd, 1993), and Cheal (Cheal et al., 1992), whose citations were added to this 
document by reference to the authors' names.  This technique makes use of the Tools 
function of the Word tool bar.  Choose Tools  Reference Manager  Insert Citation.  In 
the dialog box which pops up, type the author's last name or full name and click INSERT.  
A curly bracketed { } citation appears, which will be automatically numbered and converted 
to appropriate format when a style is chosen for output.  Until the style is chosen, the 
brackets will include the author's last name, the year of publication, and the reference ID. 

 
2. You also have a book entitled Whales of the World (Behrens, 1987) in the sample database.  

Note that the Insert Citation option discussed above does not allow you to insert a citation on 
the basis of a title—it only works for authors.  However, for this insert, you can use the Insert 
Marked Citation feature.  Browse or Search the Reference Manager Sample Database, 
which is running concurrently with your word processor.  Checkmark the record you are 
interested in running.  Go back to your word processor screen, and choose Tools  
Reference Manager  Insert Marked Reference.  There are not more choices to make, 
since the item is already marked. 

 
3. Finally, it is possible to ask Reference Manager to scan a document for markers you have 

used while you write, even when you don't insert them from Reference Manager as part of 
the writing process.  Your marker could be parentheses around an author's name, such as 
(Boyer).  When you select Tools  Reference Manager  Scan Document, the program 
recognizes the parentheses as a command to insert a citation to an item by Boyer.  Here are 
citations for the same authors who were used in paragraph one, which have been included 
using the Scan technique:  Au (Au, 1992), Boyd (Boyd, 1993), and Cheal (Cheal et al., 
1992).  Notice the nice feature that if it doesn't recognize the author (Boyer isn't in the list, 
for example), it will prompt you for correction or skip the entry.  The Scan Document dialog 
box allows you to choose the type of marker you want to use. 

 
The Generate Bibliography command automatically formats and numbers the citations in the 
body of the manuscript, as well as the style of the reference list.  Note that the style controls 
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features such as superscript citation numbers in the text, numbering and order of the references in 
the reference list.  The writer has the option of modifying the order in which items appear.  If 
you need to change the style in the future, reformat the entire thing with another command to 
Generate a Bibliography, this time choosing another output style. 
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APPENDIX I 
 
 
 
Same citation, two different output styles 
 
 

American Psychological Association Style 
 

Reference List 
 

Au, W. W. L. (1992). Application of the reverberation-limited form of the sonar equation to 
dolphin echolocation. Journal Of The Acoustical Society Of America, 92, 1822-1826. 
 

Acta Haematologica 
 

 (1)  Au WWL. Application of the reverberation-limited form of the sonar equation to 
dolphin echolocation. Journal Of The Acoustical Society Of America 1992; 92:1822-1826. 
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